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Microsoft Excel 2013 Essentials 
 

Introduction 
Microsoft Excel is one of the most widely used programs for organizing information 

and data using spreadsheets. This is due not only to the ease of learning and use of the 

program, but also to the wide range of customization options that it offers. For this 

reason, we aim to become proficient at understanding the basics of this program 

because many users in the labs are using Excel for their schoolwork. With a strong 

knowledge of the most commonly used elements, we can efficiently help users with a 

majority of their questions. 
 

 

Objectives 
1) Become familiar with the basic interface of Excel 2013 

2) Learn to create, edit and delete worksheets 

3) Format/modify tables (basic and advanced) 

4) Use formulas 

5) Understanding Referencing 

6) Create graphs and charts 

7) Use pivot tables and pivot charts 
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Navigating the Interface 
In this section, we will become familiar with the ribbon menu and the Backstage View in Excel 

2013. These menus are what you will use to navigate your way to the different tools that we are 

going to use. 
 

 First, open Excel 2013 from the start menu. 

The ȃRecentȄ window will be the first thing to open. You can open up a new spreadsheet 

or another spreadsheet you had previously been working on. Your screen will look like 

this: 
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For the purposes of this lesson plan, go ahead and click on the ȃ”lank workbookȄ icon. Then your 

screen should look like this. 
 

 

 

Now we will introduce the features and functions of the ribbon. The ribbon is the long, 

horizontal strip of menus and buttons at the top of the screen. This is where all of your tools are 

located that allow you to edit your spreadsheet. 
 

 

 Click on the ȃHOMEȄ tab. This tab contains all of your basic formatting 

functions that allow you to edit cells and the appearance of the information they 

contain. 

 Click on the ȃINSERTȄ tab. This tab allows you to place objects and images into 

your spreadsheet to supplement your data 

 Click on the ȃPAGE LAYOUTȄ tab. This tab contains all of the tools that allow 

you to edit the actual page characteristics of the spreadsheet and decide how it 

will look when it is exported to another format or printed. Here is where you 

can also decide which information to include for printing. 

 Click on the ȃFORMULASȄ tab. This tab allows you to create, edit and 

automate formulas in your spreadsheet. 

 Click on the ȃDATAȄ tab. This tab allows you to import data from other sources 

as well as manage the data in your spreadsheet.            
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 Click on the ȃREVIEWȄ tab. This tab allows you to check your document for 
errors, and it also contains tools for editing, collaborating and protecting your 

information. 

 Click on the ȃVIEWȄ tab. This tab allows you to change the views not only of 

the spreadsheet you are currently working on, but also the actual orientation 

of the program window in case you are working with multiple files. 

 

Now that we have gone over the basic elements of the ribbon, we are going to talk about the File 

tab and Backstage View. In the file tab you will find some of the options that were available 

under the Office Button menu in Excel 2010 as well as some new options.  
 

 Click on the ȃFILEȄ tab at the top left corner of the screen. 

 The program will switch to Backstage View, which looks like this: 
 

 

 
 

You will notice that there are many different options available to choose from, they 

might look familiar if you have ever used an earlier version of Excel or another Office 

program. 
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• ȃInfoȄ - allows you to protect your workbook, inspect your workbook 

for issues, manage the version of your workbook, edit browser view 

options if sharing on the web, and look at your workbookȂs properties. 
• ȃNewȄ - allows you to create a new workbook, either a blank 

workbook, a template provided on the computerȂs software, or an 
online template. 

• ȃOpenȄ - will allow you to search for a file that was either recently 

opened or used, on the UF Team Site, on your SkyDrive, or on the 

ComputerȂs drive. 
• ȃSaveȄ - will allow you to save the latest changes made to your 

workbook in the same location and under the same file name that it 

was last saved. If this is the first time saving this file, Excel will prompt 

you to choose a name and a location for your file. 

• ȃSave “sȄ - allows you not only to be specific about the file name and 

location, but also presents several other options for saving in different 

formats. 

• ȃPrintȄ - will show you a list of printing options as well as a print 

preview in the same area. This view should be very similar to you if 

you used Office 2010. 

• ȃShareȄ - will give you two options to share your workbook. You can 

share your document either through SkyDrive or through e-mail as an 

attachment (PDF or XPS), a link to a shared location, or through 

Internet fax. 

• ȃExportȄ - allows you to either create a PDF or XPS document, or 

change the file type of the workbook. You can change the workbookȂs 
file type to an Excel 97-2003 workbook, an OpenDocument Spreadsheet 

(for Open Office), an Excel template, a Macro-Enabled workbook, a 

Binary workbook, a text file (tab delimited, .txt), a CSV file(comma-

delimited, .csv), or a formatted text file (space-delimited, .prn). 

• To access even more file types, double-click on ȃSave as “nother File 
TypeȄ 

• ȃCloseȄ - will close your document without closing the program. If 

you have made changes, it will prompt you to save those changes. 

• ȃAccountȄ - will show your user information and product information. 

Underneath ȃuser informationȄ there is the option to change your 
Office Background & theme. 
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• ȃOptionsȄ - will bring up an entirely new dialog box that looks like 

this: 

 

 
 

 

 Click on the ȃOptionsȄ tab. 

This will bring up a new dialog box with the following options: 

 

• General – allows you to change the user interface, the default font 

style, view, and sheet number, as well as customize the username of 

Microsoft Office, change the background and theme, and alter start-up 

options. 

• Formulas – allows you to change calculation options, formula 

completing/entry options, error notification settings, and error 

checking rules 

• Proofing – will allow you to change autocorrect options and extra 

spelling correction options 

• Save – you can customize how workbooks are saved, when to save 
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auto recover information or when to disable it, set a default saving 

location, and offline editing options. 

• Language – allows you to set editing, display, and help languages 

• Advanced – allows you to view and change extra editing options such 

as automatically inserting a decimal point 

• Customize Ribbon – this allows you to customize what shows up 

when you click on one of tabs, such as ȃINSERTȄ, on the Ribbon 

• Quick Access Toolbar – allows you to customize what appears on the 

Quick Access Toolbar (near the Save, Undo, and Redo buttons) 

• Add-Ins – allows you to view all the Microsoft Office Add-ins, and 

manage them. 

• Trust Center – this is where all privacy statements are stored. 

 

Now that we have reviewed the basic interface of Excel 2013, we are going to transition into 

using the tools on the ribbon and in the office button menu that we are now familiar with to edit 

our new spreadsheet. 
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Creating, Deleting, and Modifying Worksheets 
Files in Excel are organized into pages called worksheets. A file or ȃbookȄ can have just 

one worksheet or it can have multiple, and in this section we are going to learn how to 

create, rename and delete worksheets. The reason that we might want multiple worksheets 

in one file is that a user could have many different types of data or several different data 

sets for one given topic, and he or she could want to keep them all in one place but still 

separate them into different pages for easy organization. Having the option to create 

multiple worksheets is a great tool for efficient data organization. 
 

There are a few different ways that you can add, delete, move and rename your worksheets. One 

way is by right-clicking on the worksheet tabs themselves and selecting an option, and the other 

way is to use the menus in the ȃcellsȄ section under the ȃhomeȄ tab. 
 

 To create a new sheet, click on the button that looks like a plus-sign at the 

bottom of the screen next to your existing worksheets. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 To rename an existing sheet, right click on the sheet you want to rename and 

select ȃRename.Ȅ Now the name of your sheet will turn into an editable field 

into which you can type a custom name. You can also double-click on the text 

ȃSheetŗȄ to edit the title of the worksheet. 

 To delete a sheet, right click on the sheet you want to delete and select ȃdelete.Ȅ 
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You can also perform these actions in the home tab under the section labeled ȃcells.Ȅ 

Here you have 3 options: insert, delete, and format. 
 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Click the Insert button and select ȃInsert SheetȄ 

 Click the Delete button and select ȃDelete SheetȄ 

 Click the Format button and select ȃRename SheetȄ 

Steps 4-6 are a different way of performing the same actions as steps 1-3, which one 

you choose to use is personal preference. 

 

If you change your mind about the order of your worksheets and decide that you want to place 

them in a different order, it is easy to change this by simply clicking and dragging the 

worksheet tabs to the desired position. To do this, click and hold the tab that you would like to 

move. As you move it horizontally, a small black arrow will appear. The sheet will drop into 

the spot where the arrow is pointing, so as soon as you see the arrow pointing to where you 

want the sheet then you can let go of the mouse and it will move into that place. 
 

Now that we have gone over how to create, delete, rename and move sheets, we can transition 

into actually entering data into the fields and learning how to manipulate that data. In the 

next section, we will learn to use the basic formatting tools as well as a few of the advanced 

formatting features. 
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Formatting Worksheet Data 
Now that we are familiar with the interface and how to manipulate multiple sheets, 

we will move on to formatting data in our spreadsheet. For this exercise, we are going 

to open up an existing workbook with an unorganized set of data and apply different 

formatting features to it. The purpose of learning how to do this is to become 

proficient at helping users be able to organize their data, make it presentable and 

quickly rearrange it without having to enter it multiple times. Formatting tools save 

a tremendous amount of time and help us create professional looking results. 
 

 Open the exercise file from your desktop. 

There will be two worksheets titled ȃexercise ŗȄ and ȃexercise Ř.Ȅ We will begin by 

working on ȃexercise ŗ.Ȅ You will be notified when to click on the ȃexercise ŘȄ 

worksheet. As you can see, we have a very long list of information that is not easy to 

read. The columns are too small to display all of the text and it is unclear how the 

information is organized. In the following steps, we will learn how to organize this 

information by applying our own criteria as well as make the information more 

aesthetically appealing. Our first step will be to adjust the width of the columns to 

match the contents. 
 

 Select the column to format by clicking the corresponding letter (ex. to select 

column A, click the letter A at the top of the sheet to highlight the entire 

column of values) 

 In the ȃHomeȄ tab, click on ȃFormatȄ from the ȃCellsȄ section. Select 

ȃAutofit Column WidthȄ and this will adjust the width of the column to the 

width of the cell containing the longest amount of text. 
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 Repeat this step for all 4 columns until they are all adjusted. 

If you have a large amount of columns and would like to do this procedure to all of 

them, you can highlight as many columns as you want and double click in the 

highlighted area when crosshairs are displayed to adjust them all at once. This can 

save time if your data set is very large. 
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Now that we have adjusted our columns, it is much easier to read the information in the 

spreadsheet. However, what if we would like to view the information in a different order, or 

what if we would like to view only parts of the information at a time? In the following steps, 

we will learn how to organize our information and view selected sections based on our own 

criteria. 
 

 Click on cell A1. There should be a bold dark green border around this cell. 

 Click on ȃformat as tableȄ in the ȃhomeȄ tab. 

At this point, your screen will look like this: 
 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You will have a range of different styles and color schemes to choose from, ranging 

from light to dark. These are samples of how your information will look once the 

formatting is applied. 
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As soon as you pick a template, a dialogue box will appear: 
 

 

 
 

 

By default, Excel will guess which information you are trying to format. As you can 

see, it has automatically selected all of our information because it is surrounded by 

the moving dotted line. If for some reason it guesses incorrectly or if you want to 

format a different area of information, you can easily click and drag your pointer 

over the data you would like to use instead. You will also see that there is a check box 

labeled ȃMy table has headers.Ȅ When this is checked, Excel will take the first row of 

information and make it into titles rather than including it into the data set. Our 

table does have headers, because as you can see each column is labeled according to 

what is contained below it. For this reason we want to keep the ȃMy table has 

headersȄ box checked. 
 

 

 Make sure the ȃMy table has headersȄ box is checked and click OK. 

As you can see, Excel has applied the formatting you selected to your data. At this 

point it is a good idea to check the entire table and make sure your information was 

formatted correctly. 
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The next step that we are going to do now that our table is formatted is to filter the 

information by category in order to be able to read it easier. This is especially helpful for 

very long lists like the one we have, because we can make it easier to read only certain bits 

of information. As you can see, after we formatted our data several arrow buttons 

appeared in the cells on the top row. We will be using these to filter our data. 
 

 

 Click on the small arrow button in cell A1. 

You should see a menu that looks like this: 
 

 
 

 

What we have is a list of all of the subcategories under the ȃcategoryȄ heading. What 

this function has done is that it has taken all of the information in this column and 

reduced it to 4 subcategories, meaning that any cell in this column will only display 

one of these 4 words. What you can do at this point is decide which information you 

would like to hide and which you would like to see. This is a very useful tool for 

filtering large sets of data like the one we have and making it easy to view it in smaller 

sections. 
 

 

 Deselect the ȃselect allȄ check box. 

 Check only the box that says ȃK-IndieȄ and click OK 
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As you can see, Excel has filtered our data so that all we see is everything that is in 

the computer category. You will notice however that the other cells did not 

disappear: they are just hidden. Look at the numbering of the cells and notice that 

they now start at 1 but skip to 38; therefore, our data has not been renumbered, just 

reorganized. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Try this with some of the other columns and see what happens when you 

select and deselect different categories. When you are done, make sure to 

choose ȃselect allȄ under each of the 5 arrow buttons so that all of the 

information appears again. 

 

If you want to remove the arrow buttons from your table, you 

can always choose to turn them off. You can do this by clicking 

the ȃsort and filterȄ button under ȃeditingȄ in the ȃhome tab.Ȅ 

Once you do that, simple deselect ȃfilterȄ and the arrow buttons 

will disappear. If youȂd like to use them again, simply re-select 

ȃfilterȄ and they will appear again. 
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We have already learned basic formatting so next we are going to move on to a few formatting 

options that are a little more advanced. To organize our data even more, we will explore some 

conditional formatting that will help us to automate the calculation of our data. 
 

Under the ȃstylesȄ section in the ȃhomeȄ tab, you will see a button labeled ȃConditional 

Formatting.Ȅ We are going to use this menu to explore some more ways that we can organize 

our data. 
 

 Click on the ȃConditional FormattingȄ button.  

You will see a menu that looks like this: 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

There are several options here for ways that we can highlight our data based on certain 

criteria. It is important to note that these rules will only apply to cells that have 

numerical data in them. For example, in our case we have columns A, B, C, and E 

which have no numerical data in them and row D which has only numbers. If we were 

to apply conditional formatting to the table, changed would only be made to row D. 

For this reason, before we apply any formatting we are going to select just that row. 

 

 Select all of the data in row ȃDȄ by dragging your mouse from cell D2 to 

D307 or by selecting column ȃDȄ at the top of the worksheet. 

 Click on the ȃConditional FormattingȄ button. 
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 Select ȃHighlight Cells RulesȄ and then select ȃGreater Than.Ȅ 

Your screen should now look like this: 
 

 

 
 

 

 In the first field, type 45. 

 In the drop down menu, make sure it says ȃYellow Fill with Dark Yellow 

TextȄ 

 Click OK 

 

 

 
 

 

Now, you will notice that every value in column D that is greater than 45 has been 

formatted to have dark red text with a light red fill color. This is extremely useful if 

you have a large amount of numerical data and would like to set rules about which 

ones you would like to stand out. This same idea applies to all of the other options in 

the ȃHighlight Cells RulesȄ menu. We will not take the time to try every single 
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option, but you can see how powerful this function can be for analyzing your data. 
 

 

 

 

The next menu that we are going to look at is directly under ȃHighlight Cells RulesȄ 

and is called ȃTop/Bottom Rules.Ȅ 
 

 

 With column D still selected, click on the ȃConditional FormattingȄ button. 

 Select ȃTop/Bottom RulesȄ and then select ȃTop 10 Items.Ȅ 

 

 

 

Your screen should now look like this: 
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This formatting option will highlight the ȃtop tenȄ numbers in the column that we 

have selected, which are going to be the 10 highest numbers in the set. If you would 

like it to highlight the top five numbers or any other amount of values, you can easily 

change that by highlighting the number 10 in the first field and changing it to 

something else. Just like the last exercise that we did, we also need to decide how we 

want to format the cells. Since we already chose to use a light red fill with dark red 

text, letȂs choose ȃRed BorderȄ instead. 
 

 

 Choose ȃRed BorderȄ from the drop down menu 

 Click OK 

 

 

 
 

 

Now, you will see that the ten highest values in the column we selected have a red 

border around them. Similarly, every other option in the ȃTop/Bottom RulesȄ menu 

will follow the same format; however we will not take the time to try every single one. 
 

 

You also have a few more options in the ȃConditional FormattingȄ menu which are 

ȃdata bars,Ȅ ȃcolor scalesȄ and ȃicon sets.Ȅ These options will apply different colors, 

styles or icons to your selected data based on their values relative to the whole set. We 

are going to do a quick exercise to illustrate this idea. 
 

 

 Click on the arrow next to Category in column A 

 Deselect all of the boxes except for the one that says ȃK-IndieȄ 

 Highlight column D which shows the number of times a song has been 

played.  
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 Click the ȃConditional FormattingȄ button, select ȃData BarsȄ and choose 

any one of the bar graph icons in that menu. 

 

 

 
 

 

You will see that colored bars are applied to your data set based on the numerical 

values in each individual cell. 
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We can also arrange this column from low to high or high to low to better 

demonstrate the trend in number of plays. 

 Click on the arrow next to Plays in column D and select ȃSort Largest to 

SmallestȄ 
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We will not go into a lot more detail explaining the ȃColor ScalesȄ and ȃIcon SetsȄ 
options, but both other options work in a similar manner. You can also change the 

rules about how these tools will format your cells by clicking on ȃMore Rules…Ȅ at 

the bottom of each menu. Take a few minutes to experiment with these options as they 

apply to your data set. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



AT Computer Labs  

23 

 

Slicers and Sparklines 
Two important features introduced in Excel 2010 have carried over into Excel 2013: 

Sparklines and Slicers. Slicers are windowed filtering tools that can help us sort our data. 

Sparklines are mini charts that can be inserted next to data to easily show the relationship 

or trend in the data. We will now be investigating how to use Sparklines and Slicers to 

enhance an Excel worksheet and make data easier to read and synthesize.  
 

 Click on cell “ŗ and go to ȃInsertȄ and then ȃSlicerȄ in the group ȃFiltersȄ. 

 

 Click the checkboxes next to ȃCategoryȄ, ȃPlaysȄ and ȃLast PlayȄ. 

 

You can check all the boxes if needed. 
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 Now you should see three slicer windows next to the table. 

 

 Slicers are almost like the windowed versions of the filter drop-downs at the top of the 

table. You can select more than one category at once and also more than one category 

across the filters. 

 

LetȂs say I wanted to know what songs had been played the least amount of times, the 

longest time ago. 

 

 Click on the 3/25, 3/31, 4/7, 4/13, and 4/14 dates (or click and drag from 3/25 

to Ś/ŗŚ) in the ȃLast PlayȄ slicer. 

 Then click 1, 3, and 4 in the ȃPlaysȄ slicer. 

 Finally click only on K-Pop in the ȃCategoryȄ slicer. 
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You can see that the slicers have allowed me to nicely filter my data so I can see what songs 

have been played the least, the longest time ago. 

To remove the filter simply click on the Filter icon with a red ȃxȄ next to it at the top right of 
the slicer window. 

 

  

Slicers are useful when you have many, many lines of data that need to be sorted in a 

specific way several times. Slicers are more easily accessible and visible than the filter 

drop-downs, but they serve the same purpose. 
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Now we will move on to inserting Sparklines into our spreadsheet. 

For inserting Sparklines, we will need to use the ȃexercise ŘȄ worksheet. 

Sparklines are little charts that can be displayed within a single cell to represent your 

selected data set. Sparklines are useful for spotting trends at a glance. We are going to 

add some Sparklines to our table of information so we can easily see trends and 

patterns in our data. We will be previewing each type of Sparkline. 

 

 Click on the ȃexercise ŘȄ tab at the bottom of the worksheet. 

This worksheet contains fictitious information about the average number of Starbucks 

drinks consumed each week by AT Staff for each semester during each year from 2001-

2012. Numerically you can see the trend but at a glance you would not be able to. 
 

 Click on the ȃinsertȄ tab. 

To the right of the ȃChartsȄ & ȃReportsȄ groups is the ȃSparklinesȄ group. There 

are three types of Sparkline charts you can insert. 

 Select cell F5. 

 

 Click on the ȃLineȄ Sparkline. 
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This dialogue box will appear: 
 

 

 

Notice that the location range coincides with the cell we selected before clicking on the 

ȃLineȄ Sparkline. We will need to highlight a data range for our Sparkline. The range 

will be from Spring 2001 to Fall 2001. 
 

 

 Click inside the ȃData RangeȄ text field 

 Highlight cells B5 through E5. 
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A ȃLineȄ Sparkline will appear in cell F5. 
 

 

  

 

 

 Insert ȃLineȄ Sparklines for the rest of years, showing plot trends 

throughout semesters within each academic year. The easiest way would be 

to click and drag the fill handle from the corner of cell F5 down to F14. 

To click and drag the fill handle, hover your mouse cursor over the bottom 

right corner of cell F5, which contains the first Sparkline. When the cursor 

changes to a bold ȃ+,Ȅ click and drag the values down to F14 and release. 
 

 

Notice that once a Sparkline is added to the worksheet, a new tab appears: ȃDesign.Ȅ 

This is where we will go to format our newly added Sparklines. 
 

 

 Click on the ȃDesignȄ tab 

There are several different formatting options available in this tab. 
 

 

 
 

 

a. You can ȃEdit DataȄ in the ȃSparklineȄ group if you feel like the 

data selected is inaccurate. 

b. The ȃTypeȄ group contains icons for the different Sparkline mini-

charts in case you want to change to a different chart type. 

c. The ȃShowȄ group allows you to choose whether or not you want to 

show the specific points in your Sparkline. Options include the high and 

low points, the first and last points, negative points, and all points 

(markers). 

d. The ȃStyleȄ group is where you can choose from a host of premade 

Sparkline formats. You can also customize your Sparklines by 

manually changing the Sparkline color and marker colors. 
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e. The ȃGroupȄ group gives you the ability to manipulate the Sparkline 

axes and group or ungroup Sparkline graphs from each other if there is 

more than one in a series. 

 

 Choose a style from the ȃStyleȄ group 

This lesson plan shows ȃSparkline Style Colorful #4.Ȅ 
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 Using the ȃMarker ColorȄ options, reveal the ȃHigh PointȄ and ȃMarkersȄ 

and choose a color for each one. 

This lesson plan shows ȃHigh PointȄ in black, and ȃMarkersȄ in a blue color. 
 

 

 
 

 

 

WeȂve just previewed one type of Sparkline graph. Let us examine the other two, 

Column and Win/Loss. 
 

 

 Click on cell G5 

 Navigate to the ȃInsertȄ tab. 

 Click on the ȃColumnȄ Sparkline 

 The same ȃCreate SparklinesȄ dialogue box will appear. 

 Higlight cells B5 through E5 for the data range. 

 Insert ȃColumnȄ Sparklines for the rest of years, showing plot trends 

throughout semesters within each academic year. The easiest way would be 

to click and drag the fill handle from the corner of cell G5 down to G14. 

To click and drag the fill handle, hover your mouse cursor over the bottom right corner 

of cell F5, which contains the first Sparkline. When the cursor changes to a bold ȃ+Ȅ 

click and drag the values down to F14 and release. 
 

 

Notice that once a Sparkline is added to the worksheet, a new tab appears: ȃDesign.Ȅ 

This is where we will go to format our newly added Sparklines. 
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 Apply a Style from the ȃDesignȄ tab and check the box to show ȃHigh 

Point.Ȅ 

This lesson plan shows ȃSparkline Style Accent 2 (no dark or light),Ȅ which 

has reddish bars. Your data will look like this now: 

 

 

 

 

 

 

 

 

 

 

 

Notice how much easier it is to determine highest value. Instead of reading the 

numbers from left to right to make a decision, we can just check out our Sparklines 

for the ȃHigh Point.Ȅ The ȃLineȄ Sparkline shows trends, whereas the ȃColumnȄ 

Sparkline shows value differences. 
 

 

Let us try the ȃWin/LossȄ Sparkline. This type of Sparkline is best for showing wins 

and losses, as the name implies. For best results, use positive numbers to signify wins 

and negative numbers to signify losses. 
 

 

 Click on cell H5 

 Navigate to the ȃInsertȄ tab. 

 Click on the ȃWin/LossȄ Sparkline 

 The same ȃCreate SparklinesȄ dialogue box will appear. 

 Higlight cells B5 through E5 for the data range. 

 Insert ȃWinn/LossȄ Sparklines for the rest of years, showing beverage wins 

and losses (in this case, only wins) throughout semesters within each 

academic year. The easiest way would be to click and drag the fill handle 

from the corner of cell H5 down to H14. 



AT Computer Labs  

32 

 

 

To click and drag the fill handle, hover your mouse cursor over the bottom right 

corner of cell F5, which contains the first Sparkline. When the cursor changes to a 

bold ȃ+Ȅ click and drag the values down to F14 and release. 
 

 

Notice that once a Sparkline is added to the worksheet, a new tab appears: ȃDesign.Ȅ 

This is where we will go to format our newly added Sparklines. 
 

 

 Apply a Style from the ȃDesignȄ tab. 

This lesson plan shows ȃSparkline Style Colorful #Ř,Ȅ which has blue bars on top, 

and orange bars on the bottom. 

Your data should look like this now. 
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Formulas 
 

Concept of Formulas and the Formulas Tab 

Formulas are equations that perform calculations on values in your worksheet. Using them 

to work out mass quantities of calculations will save them time, and the usersȂ time. If one 

wishes to apply the same calculation to a few or a large sum of data, then using the 

Formulas Tab to choose functions from the library will be helpful. 
 

• Make sure you know that in order for a formula to work, an equal sign must 

precede the actual equation; failure to do so results in an uncalculated 

formula. 

• Briefly review the order of operations and that Excel follows PEMDAS, 

which stands for Parenthesis, Exponents, Multiplication, Division, Addition, 

and Subtraction, from left to right. 

• Formulas are not limited to just numbers. Cells or groups of highlighted cells 

can be integrated into formulas as well. 

 

LetȂs practice using formulas and the formulas tab. 

 Type this formula into cell B1: 3+1+4, and click off to an empty part of the 

worksheet. 

Because the formula written down did not contain an ȁ=,Ȃ Excel did not recognize 

this as a needed calculation and therefore left it as 3+1+4. 

 Next, type this formula into cell D1: =3+1+4, and click off to an empty part of 

the worksheet. Excel completed the calculation for you. 

Since there was a proceeding ȁ=,Ȃ Excel received the signal to go through with 

calculating the equation for you. 
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 To show the use of PEMDAS, type this formula into cell C4: =3+(1+4*(1+5))-9. 

Just as any math equation and any good scientific calculator, Excel follows the 

PEMDAS sequence when solving equations and carrying out formulas. 

 

 

 

 

 Finally, to exemplify formulas using cells, add D1 and C4 into cell A7 by 

using AutoSum and highlighting each cell. 

Instead of having to try and remember cell coordinates of data, and using the plus 

symbol each time, itȂs easier to use AutoSum, which can do that for you. 
 

 

That was an example using AutoSum, but Excel has a library of other functions, and 

the Formulas Tab. 
 

 Type in numbers 1 to 9 in cells A10 through I10. 
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 Navigate to the Formulas tab. 

There are more formulas in the formula tab. Some are for everyday use, and some are 

for more specific tasks. For instance, in the Function Library group, there is a 

subgroup of formulas that can be used to work with finances, trigonometric and math 

purposes, text purposes, lookup and referencing purposes, etc. There is a large array 

of various formulas one can use in Excel. 
 

 

 

 Access the formulas Library by clicking on ȃInsert FunctionȄ from the 

Formulas Tab, or by clicking on the fx icon. 
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 Using ȃ“VERAGEȄ will compute the average of a selection into the cell. 

Average cells A10 through I10 in cell A12. 

Highlight desired range. Do not forget to close parenthesis. 
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 Click ȃOKȄ when youȂre done. 

The average will now be displayed in the cell that you have chosen. 

 Using ȃM“XȄ will figure out the maximum value in a selection. MAX cells 

A10 through I10 in cell C12. 

Highlight desired range. Do not forget to close parenthesis. 

 
 

 

 
 

 

 

 
 



AT Computer Labs  

38 

 

 

Referencing 
 

Formulas can also be used in referencing. There are two ways of referencing data in 

Excel: Relative and Absolute. 
 

Concepts of Referencing 

Relative referencing is best shown through examples, which we will be doing shortly. 

Absolute referencing always references back to the same cell. Absolute referencing ȃpinsȄ 

that cell in the calculations. Absolute referencing is identifiable by the use of dollar signs ($), 

which ȃpinsȄ either or both components of the cell coordinates (letter, number). 
 

LetȂs put the concepts of relative and absolute referencing into action to see how they 
can be useful in easily creating an effective worksheet with multiple formulas and 

interactions. 

 Open Referencing.xls 

 In cell D4, insert a formula which multiplies price and quantity. 

 Hit ȃEnterȄ or click the check mark next to the formula field. 
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 Drag the contents of D4 down to D9. 

 

 

 

Notice that while our original formula is B4*C4, it was adjusted when we dragged 

it down to D9. 

This is an example of relative referencing. Notice that the same formula applies to cell 

D6 

through D9 by taking the relative cells and multiplying them. For instance, from 

B6*C6 to B9*C9 
 

 

 In cell E9, insert a formula which totals up all the subtotals. This can be done 

using AutoSum from the formulas tab and highlighting the desired cells. 
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 Next, to calculate Subtotals and the Total with tax rate, insert a formula 

which multiplies Subtotals and the Total with the tax rate in G5, using the 

dollar symbol to ȃpinȄ the tax rate in the formula. (ie. D5*$G$5 instead of 

D5*G5). So for each box you should be entering in the Subtotal plus the 

Subtotal times the Tax Rate. 

 

 

Make sure that you are aware of the importance of using the dollar symbol correctly. 

The dollar symbol is used to pin a data coordinate in the calculations. 

 

An easy way to switch to absolute referencing (using the dollar symbols) and relative 

referencing (sans dollar symbols) is to press the F4 key. 
 

 

 
 

Finally, drag the formula down to E10 using the black crosshair to see the Grand Total 

of your Trader SteveȂs shopping cart. 

 

 



AT Computer Labs  

41 

 

 

 

Graphs and Charts 
 

Concepts of Graphs and Charts 

An interesting characteristic about charts and graphs is that they can display information in a 

much more meaningful and visual way. They can take a bland or mundane looking list and 

completely turn it into visually eye catching presentation. In addition, they convert plain data in 

a table to charts or graphs, and you can format them by using either Format as Table in Styles, or 

the Design Tab that appears for charts and graphs. 

 

We will now go over how to format charts and graphs to display our information in a captivating 

and informative fashion. 

 Open Classes & Students.xlsx 

This worksheet is a tally of how many students fall asleep on average (rounded to the 

nearest integer) during each class. It is shown in plain data, but what if this had to be 

presented to the professors of each class? It would need to be more eye-catching. 

 Click on any cell within the table of data. 

Clicking on a cell within the table of data identifies the table as the source of information. 

 Navigate to the Insert Tab 

 You will see a group of Icons above the Charts label that look like this: 

 

 

You can use any of the designs offered in either the Column Chart or Bar Chart options 

(The first two from the top left, moving to the right) to organize this data. 
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In this example I am using the  3-D Cluster Bar Chart. 

 
 

 Change the title of the graph by clicking on ȃ# “sleepȄ so that a box appears 
around it. Then double-click and replace that text with ȃStudents Asleep in 

ClassȄ 

Next, we will take a look at how to format these charts to our liking. In Excel 2010, we had 

Design, Layout, and Format tabs to help us alter our tables to our liking. In Excel 2013, 

Design and Format tabs were retained but all but one of the Layout features were moved to 

options linked to the table itself. 
 

 

 

 

 

We will first go over the Design and Format tabs before moving onto the Layout features 

linked directly to the table. 
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 Select the chart, and then navigate to the Design Tab. 

The Design tab has several options. 

• You can change the Chart type here if you feel the current type is 

unfitting. 

 

 

 

 

 

• You can switch your rows and columns (x and y axis data). 

 

 

 

 

 

 Choose a Style from the Styles Group. 

Clicking to open the drop down will show you more styles offered by Excel. You will 

notice the number of Styles available is much less in 2013 than it was in 2010. 

Hovering over each will let you know which design number it is. The example below 

shows Style 3, which has 3-D blue bars and a gray gradient background with dark gray 

text. 
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 Now letȂs navigate to the Format tab. 

• This tab has not changed much from Excel 2010 to Excel 2013. 

• You can change the basic table appearance and text appearance within the 

table as well as add shadows, insert shapes, and resize the cart. 

 

Now that we have covered the Design and Format tabs we can move on to Layout options offered 

next to the table. 
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If you click on the chart you will see three icons pop-up on the top right-hand side of the table that 

look like this: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Hover over the first icon (which looks like a plus-sign) and a pop-up tells you 

that this allows you to add/remove and edit chart elements. 

“ll options listed are very similar to the options listed in the former ȃLayoutȄ tab. 
However, in 2013 all options are much more interactive and accessible. LetȂs go through 
each option. 

 Click on the plus sign and a menu with checkboxes will appear to the right. 

 Notice that right now only Axes, Chart Title, and Gridlines are checked. 

LetȂs explore the “xes option.  

 Click on the arrow that appears when you hover over the Axes option.  

If you click on the label Axes and not on the arrows all of your Axes will 

disappear off of your chart. 

Your screen should now look like this: 
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There are two options listed, one is for showing the Primary Vertical Axis and one 

for the Primary Horizontal. However, if you wanted to edit the size, color, bounds, 

or labels of the “xis you would have to either click on ȃMore OptionsȄ at the 
bottom of the list OR double-click on either of the axes on the chart. 

 Either click on ȃMore OptionsȄ at the bottom of the list or double-click on 

either of the axes on the chart. 

 Either of these methods will bring up a side-bar that looks like this: 

 This side-bar is incredibly important to formatting our chart. You can format in 

depth any section of the chart by clicking the drop down next to ȃ“xis OptionsȄ 
right underneath ȃFormat “xisȄ and clicking on any of the areas listed. 

 

 

 

Notice that there are four icons near the top of 

the side-bar. This allows you to change not 

only the options listed but also size of the axis, 

color, and other effects. Remember that the 

vertical axis has different options than the 

horizontal axis. 

 LetȂs change some things about the 
horizontal axis of our chart. 

 You can do this either by double-

clicking on the horizontal axis or 

click on ȃMore OptionsȄ in the 
Axes menu and making sure the 

horizontal axis is the axis that is 

selected. 

 Click on the ȃ“xis OptionsȄ icon 
(the one that looks like a column 

chart). 

o Notice that our options change 

depending on which axis is 

selected. 

 Navigate to ȃTick MarksȄ and click 
on it to bring down options 

regarding Tick Marks. 

 Click the drop-down next to 

ȃMajor TypeȄ and select ȃOutsideȄ 

 Select ȃOutsideȄ for ȃMinor TypeȄ 
as well. 

o This allows our data to be more 

easily compared and read 
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The next icon that appears when we click on our chart looks like a paintbrush.  

 

Here you can edit the style or color of your chart without going back into the 

Design tab. There are separate submenus for Style and Color. 

 

You might notice that your list of color options is more limited than it was in Excel 

2010. 

 

However, you can easily change the color of your data bars by double-clicking on 

all the data bars at once 

 Double-click on all of the data bars at once. 

When you do this a side-bar will appear just like when we edited our Axes. If 

you click on the ȃFill & LineȄ Icon this menu will appear. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Make sure that you click on ȃFillȄ to change 
the fill color of the data bars. 

 

You may change your data bars to any color, 

or change each data bar to a different color. 

 

I went ahead and changed some bars to 

different colors and other bars to other colors. 

This makes the chart easier to read as classes 

are now more differentiable. 
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 Now that our table is more visually appealing and easier to read, letȂs go a step 
further and create a pie chart to better visualize the percentage of students falling 

asleep in each class. 

 

To do this we need to know how many students are in each class.  

 Insert these values into Column D next to the number of students asleep. 

 

 

 

 

 

 

 

 

 

 

  

  

Now letȂs do some math to figure out the percentage of people asleep in each class. 
 

 Go to cell E5 and enter in this formula: ȃ=Cś/DśȄ. 

 Use the fill handle to use this formula for each class. 

 To form percentages you must divide the portion of people asleep by the entire 

class size and multiply by 100. Excel 2013 has eliminated the last step in our 

formula making and we can turn all of our decimals into percentages by 

clicking one button.  

 If you go to the Number option under the Home tab you will notice an icon 

that looks like a percent sign. With all your new decimal data selected, click the 

percent button. 

 

 

263 

64 

97 

291 

230 

293 
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282 

270 

145 

255 



AT Computer Labs  

49 

 

 

 

 Now you should have a column of percentages. 

 

 

 Select your percentages and while holding down the Ctrl key select the class 

names. 
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 Then go to Insert at the top and click on the Pie Chart icon, selecting the 3-D 

chart. 

 

 

• Choose Style 8 from the Design menu. 

 

 Click on the Chart and then on the plus sign icon next to the chart. 

• Check the Legend option 

• Click on the arrow next to Data Labels to and then ȃMore OptionsȄ 
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 Make sure you click on the ȃLabel OptionsȄ icon (looks like a column chart) 

• Make sure that the Label Options section is expanded 

• Deselect ȃCategory NameȄ and then select ȃValueȄ 

 

 Double-click on the Chart Title and re-name the Chart ȃPercentage of 
Students AsleepȄ 

 

You should now see that even though Media Ethics had the largest number of students 

asleep in class, it is Operating Systems that has the largest proportion of students 

asleep. 

 

 To explode that portion of the pie, click to select only that piece and drag it 

away from the whole pie. 
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Pivot Tables and Charts 
 

Concepts of Pivot Tables and Pivot Charts 

Pivot Tables and Pivot Charts are other time saving features of Excel. They are useful when 

trying to organize an expansive list of data arranged in a columnar fashion, or vertically atop 

one another. ȃPivotȄ comes from the way users of Excel are given the power to switch data to 

and from the X and Y axes. In other words, they can pivot information. 

 

LetȂs explore Pivot Tables. 

 Open ȃPivoting.xlsxȄ 

 Click a cell within the table to identify the data collection 

 Click on the Insert Tab and click on PivotTable in the Tables grouping. 
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 The following box will appear. Click OK. 

 

 

You have the option of choosing whether or not you want the PivotTable to show in the 

same worksheet you have open, or open in a new worksheet on its own. For this lesson, I 

will choose New Worksheet. 
 

 

 
 

 

 Excel should lead you to the new worksheet automatically. Rename the new 

worksheet Pivot Table. 
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 To the right side, there is a side-bar titled ȁPivotTable FieldsȂ. Check the ȁfieldsȂ 
desired and migrate them into the areas shown at the bottom: Filters, 

Columns, Rows, and Values. 

This is in fact, where the idea of Pivot Tables and Charts comes from. You get to choose 

the fields you want to add, and you get choose which areas to place them in. Fiddle 

around with the PivotTable Field List. 
 

 

 

 

 

Now, the PivotTable is completed. See how easy it was to control your data. We 

will go over constructing PivotCharts now. 
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We can create a PivotChart using the first worksheet, so letȂs navigate to the first worksheet. 
 

 Make sure you are on the first worksheet titled Tables Charts Graphs.xlsx 

Then, click on a cell within the table to identify the data collection. 

 Click on the Insert Tab and click on PivotChart in the Charts grouping and 

select PivotChart. 

 

 

 A dialog box similar to the one that appeared when we created PivotTables 

will appear. Click OK. 

You have the option of choosing whether or not you want the PivotChart to show in the 

same worksheet you have open, or open in a new worksheet on its own. For this lesson, I 

will choose New Worksheet. 

 

 Excel should lead you to the new worksheet automatically. Rename the new 

worksheet Pivot Chart. 

 If you click in the area where there is a Pivot Chart placeholder the side-bar 

will display ȃPivot Chart FieldsȄ.  If you click on the Pivot Table placeholder 
on the spreadsheet the side-bar will display ȃPivot Table FieldsȄ.
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This should look familiar. It is the same box on the right side, with the same fields and 

areas. Again, they can choose which fields they want viewable, and the area they go in. 
 

 

 

Notice something different about choosing PivotChart instead of PivotTable? 

Choosing PivotChart makes both the table and the chart for you at the same time. 

Notice how the table and charts shift as you move from fields from area to area. 
 

 

Let us explore with filtering. We can narrow down to specific information with filters. 

Any fields from the field list that is located in the ȃFilterȄ box will show up above the 

Pivot Chart as a filter menu. To filter, we can click to open the drop down menu to 

narrow our data. 
 

 

Let us set the filter so that our table only shows data from a specific Refunder. 
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 Click to open the drop down menu, and click on ȃ“damȄ from the list and 

click ȃOK.Ȅ 

 

 

 
 
 

  



AT Computer Labs  

58 

 

 

 

Now, the table and chart should only display semester counts for Adam only. Also, 

notice that filter above the table shows us that the Refunder we are filtering for is 

Adam. 
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Let us now display semester counts for more than one person: Adam and Andrew. 
 

 

 Click to open the drop down menu and check the box for ȃSelect Multiple 

Items.Ȅ 

Check boxes will appear next to the names in the list now. 
 

 Check the boxes for both Adam and Andrew and click ȃOKȄ 
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The table should now display data on Adam and Andrew. However, notice that the filter 

above the table no longer shows us the name of whom weȂre filtering for. 

 

 

 

Since we selected more than one item in the list, it shows us ȃ(Multiple Items).Ȅ In case 

we needed a reminder of the filters we set, seeing ȃ(Multiple Items)Ȅ would not be 

helpful. To see what we checked off, we need to click on the ȃFilterȄ icon to open the drop 

down list. 

 

In this case, Slicers would be a useful tool to see which Refunders were being looked at 

while still filtering the Pivot Chart and Pivot Table. 
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Conclusion 

In this lesson, we have gone over many important topics in Microsoft Excel 2013 that 

will aid you in helping users in the labs. We have learned how to navigate the program, 

manipulate sheets, as well as create and modify tables, graphs and charts. In addition to 

that we have learned how to use formulas, explored the concepts of relative and 

absolute referencing, and lastly we learned to take our data and use it to create Pivot 

Tables and Pivot Charts. Now having the basic understanding of this program and 

being able to perform some of the most common functions will greatly improve your 

ability to provide good customer service to users in the labs. 
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Excel Activity 
 

 

Sample Product Reports 

• Format table 

o Make sure there is adequate spacing 

o Apply filters to headers 

• Apply two different types of conditional formatting 

• Subtotal Sales column 

• Apply filter for Beverages for Quarter 1 only 

o Create Pie Chart that effectively shows the type of beverage and total 

sales 
 

Sample Customer Reports 

• Format table 

o Make sure there is adequate spacing 

o Insert Column Sparklines (Hint: Use relative referencing) 

• Subtotal each sales column 

o Use relative referencing 

o Create a Grand Total 

• Create a Pivot Table and Pivot Chart 

o Include Slicers 

o Make sure it is understandable 

  

 

  


